
CCA-101:  FUNDAMENTAL of IT & Programing 

Assignment -1 

Q.1: What are the four fundamentals parts of computer ? Explain it with the help of diagram. 

Ans:-  The four  fundamentals parts of computer are: - i) Input devices ,ii) Processor(CPU) ,iii) 

Output devices, iv) Backing storage .  

 

 

 

 

 

 

 

Q.2: Discuss about the classification of computers Based on size and capacity. 

Ans:-  Based on size and capacity, computers are classified as follows:  

• Super computers 

• Mainframe Computer  

• Mini Computers 

• Micro Computers 

 

1. Super computes 

 
➢ Super computers are the most powerful and physically the largest by size. 

➢ These are the systems designed to process huge amounts of data. 

➢ The fastest supercomputers can perform over one trillion calculation in  a second. 

➢ Supercomputer have thousands of processors. 

➢ Because of their extraordinary speed, accuracy and processing power, supercomputers 

are well suited for solving highly complex problems & huge amounts of calculations. 

➢ Example: JAGUAR, ROADRUNNER etc. 

 

2. Mainframe Computer 
• Mainframe computers are very large often filling an entire room and can process 

thousand of million of instructions  per second. 

INPUT DEVICES PROCESSOR  

    (cpu) 

OUTPUT DVICES 

BACING 

STORAGE 



• In a mainframe environment, users connect to the mainframe through the many  

terminals wired to the mainframe. 

• Mainframes are able of supporting  hundreds to thousands of users simultaneously. 

• Some of the functions performed by a mainframe include: flight scheduling, reservations 

and ticketing for and airline etc  

Example: IBM mainframes Z13,IBM System z9 mainframe. 

 

3.  Minicomputers 

•  Minicomputers are much smaller than mainframes. 

• These computers are also less expensive. 

• Sometimes referred to as Midrange Severor Midrange  Computer. 

• They are typically larger, more powerful and more  expensive than desktop computers. 

• Midrange computers are usually used by small and medium-size business as their servers 

• Users connect to the saver through a network by using desktop computers. 

Example: Apple iPod , CDC 160A 

4. Microcomputers  
• Microcomputers are the most frequently  used type of compouter. 

• It is also, known as Personal Computer system designed to be used by one person at a 

time . 

   Example: Desktop computers , laptops. 

 

Q.3: What is the meaning of computer generation? How many Computer Generation are 

defined ? What technologies were/ are used? 

Ans:- Generation in computer technology is a change in technology of a computer which were                      

being used. 

In the first computer system, Vaccum tubes are used. 

Transistor are used in  the second generation. 

Integrated circuit technology were used in the third generation. 

In the fourth generation microprocessors are used. 

 

Q.4: Differentiate between Volatile &Non-Volatile memories. 

Ans 

 

 

 

Volatile memory  

1. It is a type of computes memory that 

has the capability to hold saved data 

even if the computer  is turn off. 

2. E.g. ROM, hard disk, floppy disk, etc.  

3. Secondary memory provides permanent 

storage of data and in  bulk quantity. 

1. It is a computer storage that only maintains its data 

while the device is Powered. 

2. E.g. RAM  

3. Primary memory has limited storage Capacity and         

     Is volatile . 

Non- volatile memory  



 

 

 

Q.5: Distinguish among system software, application software and open source software on the 

basis of their features. 

Ans:- System software : It is a type of software that has designed  to run a computer’s hardware 

and application programs. Software like operating systems, compliers, editors and drivers etc. 

come under this category. A computer cannot function without the presence of system 

software . 

Application software: It is a  software created for specific purpose used by end users. It can be 

called an application or simply an app. 

Example: word processer app etc. 

Open source software: It is a type  of computer in which source code is released under a 

lincense in which the  copyright holder grants users rights to study, change and distribute the 

software to anyone  and for any purpose. 

E.g. the Linux operating system. 

Q.6: a) Create  a file in MS-word to insert a paragraph about yourself and save it while name    

“yourself” . Describe all steps involved in it. 

b) Write the steps regarding the followings 

➢ To change the font style  

➢ To change the font size  

➢ To change the font color 

➢ To  highlight(in yellow) the line that reads “need to get IMS’s address”. 

Ans:- a)     “Yourself” 

                      My name is Chuiyungla. I am 22 years old. I love to play and study. I am a student of 

Ladykeane College Arts  at Shillong. Current I am learning computer CCA course at RGI TRANING 

INSTITUTION. 

 

The steps involved are: 

1. We click the Microsoft office button. 

2. We select new. The new document dialog box appears. 

3. We select blank document under the blank and recent section. It will be highlighted by 

default. 

4. We click create. A new blank documents appear in the word window. 

5. To save the document, we click again the Microsoft office button. 



6. We  select save  as        word document. The  save as dialog box appears. 

7. We select the  location where we want to save the document using the drop down 

menu. 

8. We enter the file name “ yourself” for the document. 

9. We click the save button. 

 

 

                     b) steps to change the font style: 

1. We select the text we want to modify. 

2. Left click the drop-down arrow next to the font style on the home tab. The font style 

drop-down menu appears. 

3. We move cursor over the various  font styles. A live preview of the font size will appear 

on the document. 

4. Left click the font size we want to us. The font size will change the document. 

 

                                 Steps to change the font color  

1. We select the text we want to modify. 

2. Left click the drop-down arrows next to the font color box on the home tab. 

The font color menu appears. 

3. We move cursor on the various font colors. A  live preview of the color will appear in the 

document. 

4. Left click the font color we want to use.  The font color will change in the document. 

 

 

                      Steps to highlighted the line 

1. We select the line that reads “ needs to gets IMS’s address” 

2. We click the highlight command and select yellow color in the font group on the home 

tab.  

 

Q.7: Create a file in MS- Word for the  following document and save it with file name “ms- 

word”. Describe all steps involved in it. 

Ans:- MS word is a wisely used commercial word processor  developed by Microsoft. 

          MS word is application software, which is capable of  

• Creating 

• Editing  

• Saving , and 

• Printing  any type of document  

The steps involved are : 

1. We click the Microsoft office button. 

2. We select new. The new document dialog box appears. 



3. We select blank document under the blank and recent section. It will be highlighted 

by default. 

4. We click created. A new blank document appears in the word window. 

5. We create the given documents from the question. 

6. We select the text “MS word” and change the font size by clicking on the font size 

box on the home tab. 

7. We select the  text “ MS word” to change the font the font color into red by clicking 

on the font color menu. 

8. We select the text word processor and underline command in the font group the 

home tab. 

9. We select the text “MS word” to change the font style into by clicking italic 

command. 

10. We change the font we want to format as a list and click on the bullets command on 

the home tab. 

11. We change the font color of the text “creating” and “saving” into blue and red resp 

by clicking on the font color command, again we select the text “and” click on 

strikethrough command. 

12. We select the text “printing any type of document” and change the font style into 

bold by clicking on the font style command. 

13. We save the file name as “ms-word” by clicking the Microsoft office button and 

select save as  

14. We select the location where we want save the document using drop-down memu 

15. We click the save button. 

 

Q.8: Create a file in  MS- word for the following document and save it with file name ‘equation’. 

Describe all steps involved in it. 

              

            Equatios 

         X2 + Y5  = 30 

         Z3 + Q4 `=50 

A2 + B8 = X2  +  Y8 

 

Ans:- Equations 

X 2 + Y5  = 30 

Z3  + Q4 = 50 

A2  + B8 = X2  + Y8 

 

The steps are : 

1. We create the given documents in MS-word 

2. We select the text where we want to format and click on the subscript and superscript 

command on the home tab. 

3. We save the file name as “equation” by clicking the Microsoft office button and select 

save as  



4. We select the location where we want to save the document using the drop down 

menu  

5. WE click the save button. 

 

Q.9: Create a file in MS- Word that convert existing highlighted text tom the table as shown 

below and save it as file name ‘text_to _table’. Describe all steps involved in it. 

 

               Select the text you want to convert . 

Select the Insert tab. 

Click on Table command. A dialog box appears. 

Click on Convert Text to Table,  a new dialog box  appears here set number 

of columns. 

Click on OK Finally Selected text convert in a table    

 

Select the text you want to convert. Select the Insert tab. 

Click on Table command. A dialog box 
appears. 

Click on Convert Text to Table, a new 
dialog box appears. 

Here  set number of columns. Click on OK Finally Selected text convert in a 
table 

       

 

Ans:- To convert existing text to ma table: 

1. We select the existing highlighted text that we want to convert. 

2. We select the insert tab 

3. WE click the table command  

4. WE select convert text to table from the menu. A dialog box appears 

5. We click ok. Then the text appears in a table. 

Q.10: Create a file in MS-Word to insert a table in the document. Describe all steps involved in 

it. 

Ans:-  

          

          

          

          

          

          

          

 

The steps are: 

1. We place our insertion  point in the document where we want our table to appear 

2. We select the insert tab 

3. We click the table command  



4. We drag our mouse over the diagram squares to the select the numbers of columns and 

rows in the table. 

5. Left click our mouse and the table appears in the document. 

6. We enter the text into the table. 

 

Q.11: Create a following worksheet in MS-excel and save it with name ‘book1’. 

Roll No. Name Marks

1 n1 60

2 n2 70

3 n3 80

4 n4 90

5 n5 40

6 n6 50

7 n7 77

8 n8 44

9 n9 88

10 n10 55  
  

Ans:- 

 Name Marks 
1 n1 60 
2 n2 70 
3 n3 80 
4 n4 90 
5 n5 40 
6 n6 50 

7 n7 77 
8 n8 44 
9 n9 88 

10 n10 55 
 

 

Q.12. Calculate the following things of a range (C2:C11) of data in the worksheet created in 

question no. 10. 

➢  The sum of the marks using AutoSum in a range of cells (C2:C11) 

➢ Average of the marks in a range of cells (C2: C11) 

➢ Highest marks in a range of cells (C2:C11) 

➢ Minimum marks in a range of cells (C2: C11) 

 

Ans:- 



No. Name Marks Sum Average Maximum Minimum

1 n1 60 654 65.4 90 40

2 n2 70

3 n3 80

4 n4 90

5 n5 40

6 n6 50

7 n7 77

8 n8 44

9 n9 88

10 n10 55  
 

Q.13: a) Describe the various steps involved in the following  

➢ To modify column width of a worksheet 

➢ To modify the row height of a worksheet 

➢ To delete rows and columns of a worksheet 

 

b) Describe following terms in the worksheet 

➢ Absolute reference and relative reference in formula 

➢ Cell address. 

Ans:-  a)  

➢ To modify width of a worksheet: 

i. Select a column or a range of columns. 

ii. Select a Home tab and inn the Cells group, select Format. 

iii. Click on Column width and type the width for column. 

iv. Select OK. 

➢ To modify the row height of a worksheet. 

i. Select a row or a range of rows. 

ii. Select a Home tab in the Cells group, select Format. 

iii. Click on Row Height and in the Cells group, select Format. 

iv. Select OK. 

➢ To delete rows and columns of a worksheet. 

i. Select the cell you want to delete within the column or row. 

ii. Select Home tab. And in cells group click on Delete Sheet Column or Row . 

                                              OR 

i. Select the desire row and column. 

b) :- 

➢ Absolute Reference: 
An absolute reference in Excel means there is a fixed point of reference applied 

to a cell or a formula. This is so the return value will always stay the same no 

matter where the cell or formula moves to – within the same sheet or across 

different sheet. 



This refers to a fixed point of reference is a constant, and involves the use of 

dollar sign $ in the formula (i.e., everyone is to receive the same bonus payout, 

so the amount $1500 is constant in this situation). 

 

➢ Relative Reference : 
It is the default cell reference in Excel. It is simply the combination of column 

of name and row number without any dollar ($) sign. When you copy the 

formula from one cell to another the relative cell address changes depending 

on the relative cell references. Relative references are used when we want to 

perform a similar operation on multiple cells and the formula must change 

according to the relative address of column and row. 

 

This refers to a relative point of reference, is constantly changing and dollar 

sign ($) is absent in the formula (i.e., when each unit price and quantity are 

difference variables, there’s no constant in the calculation). 

 

➢ Cell Address: 

A cell address is a combination of column letter and row number that identifies a 

cell on a worksheet. 

For example, A1 refers to the cell at the intersection of column A and row 1; B2 

refers to the second cell in column b, and so on. 

              When sed in formula, cell references help Excel find the values the 

formula should calculate. For instance, 

• To pull the value of A1 to another cell, you use this simple formula : = A1 

• To add the value in cells A1 and A2, you use this one: =A1+A2. 

 

Q.14: a) What tools are available to customize our Power Point presentation? 

           b) Write the steps for the following action creation of power point presentation 

➢ Open a Blank presentation 

➢ Save the presentation as Lab1. Pptx 

➢ Add a Title to the first slide: the name of your college  

➢ Type your first name and last name in the Subtitle section 

➢ Add a New Slide which has a Title and Content. 

Ans:- a)  

  

Tools available to customize our Power Point presentation are : 

a) Presentation 

b) Pivot Viewer 

c) Autodesk 3DS max 

d) VisualBee Power Point Add-in 

e) SmartArt 

f) Animations and Transition 

g) Wordle 



h) CA coo 

i)     Oomfo 

j) Clip champ 

 

b):- 

➢ To open blank presentation: 

i. Open PowerPoint presentation using ‘Run’ command (window key + R). 

ii. Select the ‘Blank Presentation’. It is Opened. 

➢ Save the presentation as Lab1.pptx.: 

i. Select the ‘File’ om the Tab bar. 

ii. Click on ‘Save As’ option. 

iii. Click on the document/Desktop as your choice. 

iv. Type the name ‘Lab1.pptx’. 

v. Click the ‘Save’ button. 

 

 

➢ Add a Title to the first slide: the name of your college. 

i.  Left click on the ‘Click to Add Title’ section on the first slide. 

ii. Type the name of your college. 

➢ Type your first name and last name in the subtitle section: 

i. Left click on the ‘Click to Add Subtitle’ section 

ii. Type your first name and last name. 

➢ Add a New slide which has a Title and content. 

i. Select the Home tab. 

ii. Click on the dropdown button of the ‘New Slide’ on toolbar. 

iii. Select the slide having ‘Title and Content’. It is added. 
Q15. 

Ans: 

➢ Title slide and bullet list: 

I. Open power point presentation. 

II. Select the home tab.  

III. Click at the dropdown button on ‘New slide’ at toolbar. 

IV. Select the having Title slide  and Bullet list. 

➢ Inserting Excel Sheet: 

I. Open the  slide where you want to insert excel sheet. 

II. Select the ‘insert tab’. And click on ‘object’ on tool bar. 

III. Select the ‘Microsoft Excel Worksheet’  object type. 

IV. Click the ‘ok’ button. 

➢ Clipart and text: 

I. Select the insert Tab. 

II. Select the ‘picture’ or ‘online picture’ on tool bar. 

III. Choose the appropriate art for the topic. 

IV. Click on the insert button. 



➢ Slide show effects: 

I. Select ‘Design Tab’ for themes, variants and slide size. 

II. Select ‘transition Tab’ for Cut, Fade, Push, Wipe, Split, Reveal, shape, Flash, etc. for slide 

effects. 

Q16. What is the difference between Machine language High level language? 

Ans:  

Machine language High level language 

1. A computer programming language 
consisting of binary instruction which a 
computer can respond to directly 

2. It requires no translator to translate the 
code. It is directly  understood by the 
computer 

3. This language makes fast and efficient 
use of the computer. 

1.  it is a programming language that 
enables development of a program in a 
much more user friendly programming 
context 
2. It takes additional translation time to 
translate the source code to machine 
code 
3.  they are the programmer friendly 

Q17. Discuss about different data types of c programming language. 

Ans: The different  data types of c programming language are: 

Char: the most basic data type in C. it store a single character and requires a single bite of memory  in 

almost all compilers. 

Int: as the name suggests, an int variable is used to store an integer. 

Float: It is used to store decimal numbers 

Double: It is used to store decimal numbers ( numbers with floating point value but its range  of values is 

high in comparison to float) 

Q18. Find the output of the following expressions 

        a) x=20/5*2+30-5  b) y=30-(40/10+6)+10    c)z=40*2/10-2+10 

Ans: A) X=33 

        B) Y=30 

        C) c=16 

Q19. Describe the Syntax of the following statements 

       a) if – else statement   b) for loop   c) while loop     d) do- while loop  

Ans:  a) if- else statement: 

If statements can be followed by an optional else block of statements, which execute when the bootcan 

expressions is false. 

Syntax 

If  expression) 

} 



True block of statement; 

{ 

Else 

{ 

Else of statement; 

} 

b) For loop is similar to while loop. Basic syntax of for loop is as follow;  

for (expression 1; expression 2; expression 3) 

{ 

Block of statement 

} 

In the above syntax 

Expression 1- initializes variables. 

Expression 2- conditional expression as long as this condition is true, loop will keep excuting. 

Expression 3- It is the modifier which will increase or decrease the value of the variable. 

c) while loop. 

Basic syntax of while loop is as follows 

While (condition) 

             Single statements 

Or While (condition) 

{ 

Block of statements 

} 

d) do-while loop. 

Do while loop is just like awhile loop except that the text condition is checked at the end of the 
loop rather than the start.  This has the effect of the body of the loops are always executed at 
least once 
Basic syntax of do- while loop is as follows 

Do 

{ 

Single statement 



Or  

Block statements 

}while ( condition); 

Q20. Find out the output of the following program segments 

 

 

Ans: A) 1 

        B)  2 

        C) b=100 

 

 

 

 

 

 

       

     

 

a) b) c) 

#include<stdio.h> 
Int main() 
{ 
  Int I; 
   For(i=1;i<2;i++) 
  { 
   Print(“IMS Ghaziabad/n”); 
  } 
} 
 

#include<stdio.h> 
Int main() 
{ 
  Int i=1; 
  While(i<=2) 
  { 
   Print(“IMS Ghaziabad\n”); 
I=i+1; 
  } 
} 

#include<stdio.h> 
Void main() 
{ 
  Int a = 10, =100; 
  If(a>b) 
  Printf(“Largest number is       
%d/n”,a); else 
  Printf(“Largest number is 
%d/n”,b); 
} 


